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1. Jason Camlot: What is SpokenWeb?
What is digital about SpokenWeb?
Media Formats, Audiotextual Forms, Literary Affordances

Digital projects of the SpokenWeb research program



What is SpokenWeb?



Reel to Reel tapes documenting the Sir
George Williams Poetry Series
(1965-1974)
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What is The SpokenWeb?

- Aims, methods, activities: In what ways will it engage
with sound?

- SpokenWeb Collections: The (expanding) scope of
our audio corpus.



What is SpokenWeb?

A SSHRC-funded research partnership (PG)
and network currently made up of 15+ partners
(institutional, community, organizational) across
the US and Canada and 50+ researchers (and
30+ students and PDFS) working on the
development of digitized collections of literary
sound recordings in order to make them
accessible for use in research and teaching,
and on research, teaching and “knowledge
mobilization” activities with the digitized
collections.



Who is SpokenWeb?

Present Institutional Partners
Holding Collections: Simon Fraser U, U British Columbia Okanagan, U Alberta, U Calgary,
U Toronto, Victoria U in the U Toronto, Concordia U.
Holding Relevant Expertise: U Texas at Austin, UC Davis, NYU, U Pennsylvania
(PennSound), U Victoria, etc.
Other Partners
Wired on Words, Archive MTL, Blue Metropolis Foundation, Compute Canada
Researchers, selected (Co-Applicants and Collaborators)
Lit: Jason Camlot, Gregory Betts, Clint Burnham, Al Filreis, Michelle Levy, Smaro
Kamboureli, Mike O’Driscoll, Karis Shearer, Darren Wershler, Jason Wiens, Cecily
Devereux, Carole Gerson, Nick Mount.
Library and Archives: Rebecca Dowson, Roma Kail, Sean Luyk, Loryl MacDonald, Tomasz
Neugebauer, Felicity Tayler, Jared Wiercinski, Geoff Harder, Marjorie Mitchell, Tony Power,
David Seubert.
Community: lan Ferrier, Louis Rastelli, William St-Hillaire.
DH: Tanya Clement, Adam Hammond, Marit MacArthur, Brian McFee, Lee Miller (as
consultant), Geoffrey Rockwell, Miles Thorogood.
Oral History: Steven High.
Media History: Patrick Feaster, Matthew Rubery, Jenterey Sayers, Jonathan Sterne.
Podcasting: Hannah McGregor.
Student Researchers, PDFs and “HQP” (lots of them). A Student Advisory
Committee of approx. 25 students to start with.




Some Aims

Inventory and index existing collections in Canada, held by institutional
and community partners, to establish a broad understanding of our
national holdings of literary sound recordings, and, digitally preserve and
aggregate these collections by developing a metadata scheme.

Study literary recordings using interdisciplinary theories and methods of
“audiotextual criticism”.

Develop and test computational methods for analyzing literary sound.

Create online modules, interactive aural exhibitions and new works of
sound art from the digitized archive for use in research, teaching and
public presentation, allowing the archive to speak and tell stories in new
ways.



Methods

The SW research program is designed to explore

1) the history of literary performance and practice as discernible in sound recording media,

2) cultural effects of the circulation of digitized literary recordings, and

3) how engagement with sound recordings can have the effect of changing disciplinary
practices in research and teaching, by mixing methodologies from literary, media and

sound studies, oral history, digital humanities, digital libraries, and archival theory.

We’ll introduce new methodological approaches to the field of literary studies, revise the
nature and format of literary canons, etc.



SpokenWeb Collections:
The (expanding) scope of our audio corpus

Time frame: mainly 1960-2000

SFU collections hundreds of hours of readings, lectures, interviews, literary conversations,

UBCO collection holds multiple homemade literary audio tape collections of Canadian poets including
readings, compilations and literary dictation.

U Alberta collections document local reading series.

U Calgary collections hold recordings made by individual Canadian authors.

Concordia U collections hold documentary recordings of literary performance, multimedia literary/art
practice, individual author tape collections

U Vic holds a rich collection of formal literary interviews

U Toronto holds collections that document practices of literary pedagogy, and French language
reading series.

Wired on Words holds a “words and music” reading series that has run from 1980s to the

present.

ARCMTL counterculture collections, dumpster dive materials.

Hidden Collections: We have a mandate to seek out collections that have not been deposited in archives,
digitize, preserve and integrate them into our project (with the source materials to be deposited in partner
archives or kept by the holder of the collection.

A few examples:
Yellow Door Readings (36 Cassette tapes documenting a readings series from the early 1990s).
Ultimatum Festival and Readings: 39 reel to reel tapes plus several U-Matic video tapes of a bilingual punk
poetry series that took place in Montreal in the mid 1980s.

We did a survey and there are MANY more such collections out there in shoeboxes, in basements.
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Montreal

CllJ:@8 SGW Reading Series Oral Literary History || Poetry Readings in Canada

SGW POETRY READING SERIES

Between 1965 and 1974 members of the Sir George Williams University (SGWU, now Concordia University) English Department in
Montreal hosted a series of poetry readings that was conceived as an ongoing encounter between local poets and the avant-garde
poetics of some of the most important writers from the United States and the rest of Canada. Sponsored by “The Poetry
Committee” of the Faculty of Arts and the SGWU English Department—and organized primarily by English professors Howard Fink,
Stanton Hoffman, Wynn Francis, Irving Layton, Roy Kiyooka, and (from 1967-71) George Bowering—these readings involved more
than sixty poets from across North America.

Known simply as “The Poetry Series”, audio recordings of these readings were made on Mylar 1 mil. tape using mobile reel-to-reel
tape machines. The Concordia University Archives received a grant in 2007 that has allowed all 65 reels of tape (more than 100
hours of audio) to be digitized. So, this sound from an interesting period of transformation in Canadian poetics, and of self-
scrutiny for Montreal poetry, represents a rich and useable archive for scholarly research.

SORT BY [PEGY Author

FILTERS

Search

Y



What is digital about SpokenWeb?



Researchers pursue projects via collaborative Task Forces.

(META) DATA PROCESSING AND MANAGEMENT
* Metadata Task Force

* Systems Task Force

* RDM Task Force

* Analog/Digitization Task Force

* Rights Management Task Force

ANALYSIS Literary or Audiotextual Research
* Audio Signal Analysis Task Force doesn’t have a task force as it is an
CONTEXTUALIZATION /HISTORICIZATION assumed form of activity, being

* Oral History Task Force reshaped by the rest...

KNOWLEDGE MOBILIZATION

* Podcasting Task Force

* Pedagogy Task Force

* Archival Events Task Force

*  Community Collections Task Force

ETC.
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FABRIQUE AU CANADA
1200 FT. TYPE A-15

HEAVY DUTY ACETATE

A brief

and heroic
history!

L KRAMER MAGNETICS LIMITED « Port Credit, Ontario, Canada
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Close listening as
a practice of
consignation



Extra-poetic speech
as information field

... or, Phyllis Webb:
“I have to catch my

breath.”



Oral history:
archive stories
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Archival history
and the
paratextual
environment



Audiographic codes
and the production
of meaning
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Daphne Marlatt at SGWU, 1970 Timestamps
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" *“Lagoon”
00:00/42:25
around the Frasier Delta in Vancouver. The thing that interested me the most about the o1t42; Reads’lagoon '
Kwakiutl were one particular secret society called the "Hamatsa" and in the Hamatsa it o349 'Mroduces “Wet fur wavers”

]

writes, one goes into a sort of frenzy and is possessed by the original spirit, who then
26:56 Reads “Wet fur wavers”

passed on the rituals, and the frenzy denotes the acquirement of a certain kind of
power. | guess the Salish have something a little corresponding to that in that they
have, | don't know what you call them, they're certain kinds of dances which are meant
to perform the meeting between the individual who dances, the initiate, and the spirit 10:34
of the particular place whom he encounters and who gives them, in result of this

dance, particular powers. "Wet fur wavers", this is a Spanish Banks poem, about a walk,

a Sunday walk along the Spanish Banks.

88:16 Introduces “Go on”

28:54 Reads“Goon”

Introduces “razorbackt
woman"”

12:85 Reads “razorbackt woman”

Introduces “Alcazar, Cecil,
Belmont, New Fountain,

13:56 2
names stations of the way,
to”
Annotation Reads “Alcazar, Cecil,
{3553 Belmont, New Fountain,
90:06:56 """ names stations of the way,
Reads "Wet fur wavers". to
__ Introduces “Bugs in the
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Indexing and durational media
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() UNIVERSITY OF ALBERTA
&’ LIBRARIES

luyk@ualberta.ca v

education & research archive

ERA

» AUDIO + VIDEO

Search ERA A+V

Browse ERA A+V

You can also learn more about this service, or contact us.

https://era-av.library.valberta.ca

\J/\J‘JW

MEDIA SYSTEM

https:/ /www.avalonmediasystem.org



https://era-av.library.ualberta.ca
https://www.avalonmediasystem.org/

@ UNIVERSITY OF ALBERTA education & research archive
&7 LIBRARIES

ERA Home enter search terms Search ERA A+V

luyk@ualberta.ca ~

» AUDIO + VIDEO
Home Browse Manage Content Manage Groups Manage Selected Items (0) Playlists Contact
Browse By « Previous | 1- 10 of 2,287 | Next » Sort by Date 10 per page v
Format v
~1Select All
Sound Recording 1763 1. Ivars Taurins Lecture & Rehearsal with USO, Madrigal Singers & Concert Choir (2:00:10)  — geject
Moving Image 516 g - Date:  {2003-03-26, 2003-03-27}
Main contributors:  Taurins, Ivars

Main contributor >

Date >

Genres > 2. Student Composer Recital - 260 & 460 levels (1:07:03) 7 Select
Collection > Date {1395-04-03, 1995-04-05}

‘ Main contributors:  Various
Language >
o 3. Programa Nosotros. (59:43) Select
1 : - !
Limitio e Date: {1993-02-21, 1993-02-28} (Creation date: 1993-02-24)
Published > Main contributors: Marlg Allegde A A -
Summary: Continuation of a series. A conference in Vancouver with the consulate
Created by > General of Peru Jaime Pomerada on promoting Latin-American culture, and the difficulties of living far from
one's home and cul...
External Group >
Date Digitized > 4. Prq?rama Nosotros. Bafochi (1:02:13) 5 Select
> Date: {1991-10-20, 1991-10-27} (Creation date: 1991-10-20)
Date Ingested > Main contributors:  Sergio Contreras

Summary:  This program presents a report on the relief telethon for the cholera
epidemic in Peru. The report discussed the donations gathered and the various people and groups involved
in making the telethon...




ERA A+V /Avalon: Core Features

Collection search and discovery

Media deposit workflow management

Single sign on (through campus computing ID)

Learning Tool Integration with UA LMS

Basic access control

Ability to embed content into websites, create playlists, and display closed
captioning

Standards-based metadata (MODS), persistent URLs, and structural

metadata (basic XML using div, span, begin, end elements) I ‘:RA

» audio + video

(-



Qutline

1. High-level metadata considerations
2. SpokenWeb Metadata Task Force
3. High-level systems considerations
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https: //collectionsasdata.github.io/



https://collectionsasdata.github.io/

“Audiovisual materials are notoriously under represented in digital
humanities precisely because they often lack the detailed data (or
metadata) that supports their effective discovery, identification, and use

by researchers, students, instructors, or collections staff”

-Tanya Clement, “Unsolved Problems in the Humanities Data Generation Workflow: Digitization
Complexities, Undiscoverable Audiovisual Materials, and Limited Training for Information

Professionals,” Always Already Computational: Collections as Data Final Report, p. 106.

“...even the most basic metadata is often more useful for understanding a
collection than many librarians imagine. Simply having author or creator
information, or language information, can be very helpful”

-Miriam Posner, “Actually Useful Collection Data: Some Infrastructure Suggestions,” Always Already
Computational: Collections as Data Final Report, p. 135.



Metadata Task Force

}Swollow veRsion 1.0

= = DASHBOARD
DASHBOARD
.... CATALOGUERS REGISTERED . @ COLLECTIONS CREATED ITEMS DESCRIBED
ogye
000 ‘ @
LYo
COLLECTIONS
@
“ TOP CATALOGUERS COLLECTIONS SIZES LATESTS ITEMS ADDED
ITEMS
Jakob Jakob 29 Hartmut Lutz Colection 29 12/12/76 Mattie Falworth & Guy Birchard
Tomasz Neugebauer 2 Véhicule Art (Montréal) Inc. fonds (P027) 2 Lance Henson; Cheyenne; Interview; Hartmut Lutz Collection;
-ﬂ Lance Henson; Cheyenne; Hartmut Lutz Collection; 1987
MPORT
Lance Henson; Cheyenne; Willard Rhoades; Storytelling; Hartmut

Lutz Collection; Germany; 1986

| - Carolyn Attneave; Deleware; Lecture; Hartmut Lutz Collection;
California; 1980

Tomasz Neugebauer, Francisco Berrizbeitia, and Jared Wiercinski. Swallow (SpokenWeb Audio Metadata Ingest

System) v. 1.0, Landing Page.



Structural Metadata in Avalon

Edit Structure
File Edit Select View Options Raw XML | Graphical
Edit Structure
Item | Unsaved changes
(x) label Sallie Bakes a Pie aad Subslement
Div File Edit Select View Options Raw XML | Graphical Save and Exit
Span X Span
’ 1~ <Item label="Sallie Bakes a Pie">
Add Attribute
() label The Crust () begin 00:00:00.00 2 <Span label="The Crust" begin="00:00:00.00" end-"00:03:30.00"/> LasEac chenges
(x) end 00:03:30.00 label 3 <Span 1abe1="The_Filling'.' begin="00:03:30.00" end="00:09:00.00"/> Ad
Add Top Element 4 <Span label="Baking" begin="00:09:00.00" end="00:10:00.00"/>
) 5 </Item> Al Attribite
Div AQQ ATripute
Span LThX Span [
Add Top Element
(x) label The Filling (%) begin 00:03:30.00
(x) end 00:09:00.00 Div
Span
Span IR
(x) label Baking (x) begin 00:09:00.00
(x) end 00:10:00.00

Avalon Media System, Collection Manager’s Guide, “Adding Structure to Files Using the Graphical XML Editor”
<https:/ /wiki.dlib.indiana.edu/display /VarVideo /Adding+Structure +to+Files+Using+the+Graphical+XML+Editor >



https://wiki.dlib.indiana.edu/display/VarVideo/Adding+Structure+to+Files+Using+the+Graphical+XML+Editor

Structural Metadata - New Graphical Editor

» 0:00/000 @ ® L&
Add a Heading Add a Timespan
Planet Earth - BBC /s
Music (00:00:00.00 - 00:01:15.00) 0 7/ i
Title VA |
Intro (00:00:15.00 - 00:01:30.00) o /7 i
Part | (0 - 00:03:00.00) o / W
Part |1 (00:04:00.00 - 0) 0 /7 ¥
Outro (00:04:30.00 - 00:05:00.00) 0o /7 i
Midiro (00:05:00.00 - 0) o 7/ i
Save Structure

Avalon Media System React Structural Metadata Editor <https://qithub.com/avalonmediasystem/react-structural-metadata-editor> (r
&


https://github.com/avalonmediasystem/react-structural-metadata-editor

Sterne’s Roadmap vs. ERA A+V /Avalon

Functions Current Functionality
Platform independence X
Limited downgrading v
Ease of navigation V

Use of lossless formats

X (at ingest only)

Supports looping X
Displays related files with audio (e.g. images) X
Range of visualization options (waveform, spectral display, rhythm, etc.) X

X

Ability to configure audio (e.g. mono vs. stereo)

Manipulate audio (speed up, slow down, scrubbing, freezing, marking)

v (scrubbing, marking)

https: //superbon.net/2011 /07 /24 /audio-in-digital-humanities-authorship-a-roadmap-version-0-5/ (2011)

(7


https://superbon.net/2011/07/24/audio-in-digital-humanities-authorship-a-roadmap-version-0-5/

Systems Task Force - Next Steps

| _:-x‘..: :

Specify Context
of Use

Evaluate System Specify

Designs R Requirements
& Satisfies 9

Produce Design

Solutions

® Gather Requirements:

O

O

O

O

Specify the context of use
Determine user requirements
Recommend design solutions

Evaluate designs through usability testing

® lterate changes as necessary

“Scholarly software designers should more

consider the research on user-centered design

approaches...and theories associated with user

experience”

-Gibbs, Fred and Trevor Owens. “Building Better Digital Humanities Tools: Toward

broader audiences and user-centered designs.” Digital Humanities Quarterly 6 /2

(2012) <http://www.digitalhumanities.org/dhq/vol /6 /2/000136/000136.html>

(-


http://www.digitalhumanities.org/dhq/vol/6/2/000136/000136.html
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Avalon

Metadata fields:

\/
%*

/7
%®

7/
%®
7/
0‘0

\/
%*

/7
%®

o
X3
o
o
o
X3

\/
%*

Title (Required)

Date Issued (Required)
Bibliographic ID
Bibliographic ID Label
Other Identifier
Other Identifier Type
Creator

Contributor

Genre(s)

Publisher(s)

Date Created
Abstract

Language(s)

O 0 0 O 0 0 O O O
P 00 00 00 060 00 00 00 O

SR/
A XA X4

Physical Description
Related ltem URL
Related ltem Label
Topical Subject
Geographic Subject
Temporal Subject
Terms of Use

Table of Contents
Statement of
Responsibility

Note

Note Type

From: https://wiki.dlib.indiana.edu/display /VarVideo /Batch+Ingest+Package+Format



SpokenWeb

Metadata fields:

X
o
o
o

o
o
RS
o
o
o
o
o
o
o
o
o
o
o
o
o
o

O
L X4

Cataloguer Last Name, First Name

Partner Institution
Contributing Unit

Source Collection

Source Collection Description
Source Collection ID

ltem ID Number/ Identifier
Persistent URL (if available)
Asset Image File Name
Recording Type

AV Type

Material Designation
Physical Composition
Storage Capacity of Artifact
Extent Side

Playing Speed

Track Configuration
Playback Mode
Equalization

Tape Brand

Accompanying Material
Other physical description

R
L X4

L X4

O % % % % %
X X X I X R X X4

2
4% O

3

8

X3

S

O % % % o
L X X X X I X4

%

S

3

8

>

R
*

O o
L X X

Generations
Sound Quality
Physical condition
Conservation
Other Digitized file name
Digital File Path
Channels

Sample rate
Precision

Duration THH:MM:SS
Size

Bit rate

Encoding

Title

Title Note

Title Source
Language
Production Context
Genre

Creator 1

Creator URL

% % % <%
L CGIR XCIE XQ X

R
L X4

*
> %S % o

oo ol oo

O % % % % % % % % %% %
L X X X X IR X R X X X X X iR X

Creator Role 1

Contributor 1 Last, First Name
Contributor 1 URL
Contributor Role 1
Contributor 2

Contributor 2 URL
Contributor Role 2
Creator/Contributor Notes
Date

Date Type

Date Source(s) of Information
Date Notes

Address

Venue (enter if available)
Address Notes

Latitude

Longitude

URI

Rights

Rights Note

Time Stamp Begin

Time Stamp End
Duration

Title of Work
Other Notes



SpokenWeb UAlberta

Metadata fields:

\/
%*

/7
%®

7/
%®

7/
0‘0

\/
%*

/7
%®

7/
%®

7/
0‘0

SW Catalogue Number

AV Catalogue Number (original)
Format

Reader(s)

Additional Speaker(s)

Genre

Venue

Date

o 0 O 0
P 00 00 o0

X/
& 00

Technical Specifications

Recording Specifications

Photo /Scan Files

Notes from reel /cassette case and/or
accompanying documents

Time Stamps

General note



SpokenWeb UAlberta and Avalon

https: //docs.google.com/spreadsheets/d /1m3upspTHNH8Om20oF4xYp
JRxNoDITXrZvkugTiKRxCHk /edit2usp=sharing



https://docs.google.com/spreadsheets/d/1m3upspTHNH8Om2oF4xYpJRxNoDITXr7vkuqTjKRxCHk/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1m3upspTHNH8Om2oF4xYpJRxNoDITXr7vkuqTjKRxCHk/edit?usp=sharing

SpokenWeb UAlberta and SpokenWeb

https: //docs.google.com/spreadsheets/d/1FzZDmHEUqpDsI3CcNODUC

aax0157FDEjfgMpTiBuXFw /edit2usp=sharing



https://docs.google.com/spreadsheets/d/1FzZDmHEUqpDsI3CcN0DUCqgx0157FDEjfgMpTiBuXFw/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1FzZDmHEUqpDsI3CcN0DUCqgx0157FDEjfgMpTiBuXFw/edit?usp=sharing

SpokenWeb UAlberta and Avalon and SpokenWeb

https: //docs.google.com/spreadsheets/d/1jgNézs8xu 04rK9E1CkQqg
18PYLfgRJ4gxJaaGRZ8NSI/edit2usp=sharing



https://docs.google.com/spreadsheets/d/1jgN6zs8xu_04rK9E1CkQg18PYLfqRJ4qxJaaGRZ8NSI/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1jgN6zs8xu_04rK9E1CkQg18PYLfqRJ4qxJaaGRZ8NSI/edit?usp=sharing

Resultant Recommendations

%  Cataloguer name
> This comes from SpokenWeb’s schema. The cataloguer is an important part of the collection of these items.
% Source Collection
> This comes from SpokenWeb’s schema. Our collection should have a name.
% Source Collection Description
> This comes from SpokenWeb’s schema. Our collection should have a description.
% Other Identifier Type
> This comes from Avalon - we have a Catalogue Number (“Other Identifier” in Avalon-speak) but we need to assign it a type for
Avalon.
% Digital File Path
> This comes from SpokenWeb’s schema. Helps with organizing.
o Title
> This comes from both SpokenWeb and Avalon - Avalon requires this.
% Title Source
> This comes from SpokenWeb’s schema. Where did this title come from? Is it from the box or from the cataloguer?
%  Language
> From both SpokenWeb and Avalon. Easy enough to do and helpful for searches.
% Topical Subject
> This comes from Avalon - These come from the Library of Congress Subject Headings and are important for people searching a site

to be able to find what they're looking for. Keywords, basically.



Resultant Recommendations 2

%  Statement of Responsibility
> From both SpokenWeb and Avalon. This tells us who is who (creator, reader, publisher, etc. as creator or contributor) for Avalon’s
system.
%  Date Type
> From SpokenWeb. What kind of date is our date? We will be using multiple types of dates in Avalon likely, so it would be good to
have it written down what they are.
% Terms of Use
> From both SpokenWeb and Avalon. Crucial for putting things online.
% Time Stamp Document, found here:
https://docs.google.com/spreadsheets /d /THRrCT{UNK1LX7 50cHkqlbC8yGQghUMOGRauH-tS5sRQ /edit2usp=sharing
> Includes:

Unique ID

Time In
Time Out
Title

Text

Notes
m  Type
%  Related Item URL
> From Avalon. Nice to have for an online database
%  Related ltem Label

> From Avalon. What is this item?


https://docs.google.com/spreadsheets/d/1HRrCTjUNK1LX75ocHkqlbC8yGQghUM0GRauH-tS5sRQ/edit?usp=sharing

Future Steps

<+ mandatory versus optional categories

« Ul design according to metadata categories
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Why a University of Alberta portal?

* The SpokenWeb project is a partnership of distributed centers
* Intellectual property issues

* The need for a family resemblance to the central site



How do we design a portal to the spoken word?

The characteristics of the persona/scenario/wireframe process
* Controlled method
* Time-consuming method

* Series of distinct phases



Personas

“Personas are not real people, but they represent them throughout the design process. They are hypothetical
archetypes of actual users. Although they are imaginary, they are defined with significant rigor and
precision” (Alan Cooper)

“Not knowing who you are designing for increases the risk of ending up with a product that makes nobody
sufficiently satisfied” (Stephanidis, Universal Access in Human-Computer Interaction)



Personas
1. Abigail McGlenn

Occupation: retired teacher

Age: 73

Location: Fredericton

Potential audience group: Researcher

Abigail McGlenn is a retired teacher. She interested in poems. Every week she goes to a book
club where she and her friends read a book in the field of Literature. She is not an expert but
she wants to become more informed. She is enthusiastically searching the portal and listening
to the tapes. She enjoys listening the tapes and reading the texts; even, she posts SpokenWeb

portal’s materials on her social media.|



Scenario

Scenarios ‘“‘explain the future activities”, they depicts steps that a user performs
to complete the task.

1.Abigail and her friends read a short story from Jorge Luis Borges in their book club.

2. She searches his name to know more about him.

3. She finds Borges’s page on the SpokenWeb portal.

4. She listens to the tape and reads the text.

5. She takes some notes.

6. She bookmarks the page.

7. She posts the link on her book club’s Facebook page.



Scenario

Website user flow
Abigail McGlenn|
(Persona 1, Retired Teacher)

Homepage

¢

Search bar

&

Collection

TS ERS

Sharing on social media



Wireframes

“Wireframes are schematic presentations that define a webpage’s content and functionality

structure in order to portray the page concept before it is designed and developed”(Kotze & et al.)

Home/welcome page
€ = @ i [vaberaspokenweb.ca

COLLECTION

é 9 e £ [caberta-spokenweb.ca

Q, search
Collection J ( About Us J ( Resources H Log in J
The SpokenWeb project invites you to discover and EVENTS
listen to its online archive of oral literary history; donate
to help the collection grow.
Tape of the day
> =
Get Involved SpokenWeb Blog
iversity of Alb SOCIAL MEDIA ICONS (LINKS)
(Cweriy i) | ' . | —
( Button ) ' Privacy policy information

Tape

6 9 e £ [ualberta.spokenweb.ca

Q search
//( Collection ) ( About Us ] [ Resources H Log in )

[ FAQ

Q, search
//( colecion ) (_Atoutus ) (Resowces (" Login )
Fliters
Sortby
Date
Author
Get Involved SpokenWeb Blog
( Un,\,milyd%gna) | SOCIAL MEDIA ICONS (LINKS)
= = Contact
( Buton ) (‘Privacy policy ) information

( Buon ) (A )

FAQ

I P e —— | Tags
( Creat a Playlist J ( Share )
Tape Time Transcript
Descripton
Recommended!
Get Involved SpokenWeb Blog
University of Alberta SOCIAL MEDIA ICONS (LINKS)
(—] | - - ] Contact
Privacy policy information




Implementation framework

* ERA AV (Education and Research Archive Audio-Visual) for the Content

 Catfish for the Interface

A Web Content Management System (WCMS) “provides website authoring, collaboration, and administration
tools designed to allow users with little knowledge of web programming languages or markup languages to

create and manage website content with relative ease” (Jin & Lin, Advances in Electronic Commerce).

https: //arc.arts.ualberta.ca/



https://arc.arts.ualberta.ca/

=

Thank you

Discussion / Questions

spokenweb.ca
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